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1. Vigtigt

1. Vigtigt

Denne elektroniske brugervejledning er 
beregnet til alle, der bruger Philips-skærmen. 
Tag den tid du behøver for at læse vejledningen, 
inden du bruger skærmen. Den indeholder 
vigtige oplysninger om bemærkninger angående 
brugen af din skærm.

Philips garanti dækker under forudsætning af, 
at produktet behandles korrekt og anvendes til 
det tilsigtede formål i overensstemmelse med 
dens brugervejledning, og ved forevisning af den 
originale faktura eller kvittering med angivelse af 
købsdatoen, forhandlerens navn samt model og 
produktionsnummer for produktet.

1.1 Sikkerhedsforanstaltninger og 
vedligeholdelse

Advarsler
Anvendelse af betjeningselementer, justeringer 
eller fremgangsmåder, der ikke er beskrevet i 
denne dokumentation, kan resultere i elektrisk 
stød, elektriske ulykker og/eller mekaniske 
ulykker.

Læs og følg disse vejledninger, når du tilslutter 
og anvender din computerskærm:

Betjening
Hold venligst skærmen væk fra direkte 
sollys, meget stærkt og lyst lys samt fra alle 
varmekilder. Længere tids udsættelse for 
sådan et miljø kan resultere i misfarvning 
og skade på skærmen.

Fjern alt, der kan risikere at falde i 
ventilationsåbningerne eller forhindre 
korrekt afkøling af skærmens’ elektronik.

Bloker ikke ventilationsåbningerne på 
kabinettet.

Under placering af skærmen skal du sikre 
dig, at det er let at komme til strømstikket 
og stikkontakten.

Hvis der slukkes for skærmen ved at fjerne 
strømkablet eller jævnstrømsledningen, 
skal du vente 6 sekunder, før du sætter 

strømkablet eller jævnstrømsledningen til 
igen for at opnå normal betjening.

Brug altid et godkendt strømkabel, der 
er leveret af Philips. Hvis du mangler dit 
strømkabel, skal du kontakte dit lokale 
servicecenter. (Se Informationscenter for 
kundepleje)

Udsæt ikke skærmen for kraftige 
vibrationer eller stød under anvendelse.

Slå ikke på skærmen, og undgå at tabe den 
under brug eller transport.

Vedligeholdelse
Som en beskyttelse af skærmen skal du 
undgå at trykke kraftigt på LCD skærmen. 
Når du flytter din skærm, så tag fat 
om rammen for at løfte den. Løft ikke 
skærmen ved at sætte din hånd eller fingre 
på LCD skærmen.

Tag stikket ud fra skærmen, hvis du ikke 
skal bruge den i en længere periode.

Tag stikket ud at kontakten til skærmen, 
hvis du skal rengøre den med en let fugtet 
klud. Skærmen kan tørres af med en tør 
klud, når der er slukket for strømmen. 
Under alle omstændigheder, må der ikke 
bruges organiske opløsningsmidler til 
rengøring af din skærm.

For at undgå risiko for elektrisk stød eller 
permanent beskadigelse af anlægget, må du 
ikke udsætte skærmen for støv, regn, vand 
eller miljøer med høj fugtighed.

Hvis din skæm bliver våd, skal den tørres af 
med en tør klud så hurtigt som muligt.

Hvis der kommer fremmed substans eller 
vand ind i skærmen, så sluk straks for 
strømmen og tag stikker ud. Fjern derefter 
den fremmede substans eller vandet, og 
send skærmen til servicecenteret.

Skærmen må ikke bruges eller opbevares på 
steder, hvor den udsættes for varme, direkte 
sollys eller ekstrem kulde.

For at opretholde den bedste ydelse 
af din skærm og for langvarig brug, 
bedes du bruge skærmen et sted, der 
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er indenfor følgende temperatur- og 
fugtighedsområde.

Temperatur: 0-40°C 32-95°F
Fugtighed: 20-80 % RH

VIGTIGT: Sørg altid for at aktivere 
en pauseskærm, der bevæger sig, når 
skærmen efterlades uden at blive anvendt. 
Du skal altid bruge en pauseskærm 
eller et andet program, der opdaterer 
skærmen regelmæssigt, hvis skærmen 
viser statisk materiale i længere perioder. 
Uafbrudt visning af et stilbillede over 
længere tid, kan forårsage “brandmærker”, 
også kendt som “efterbilleder” eller 
“spøgelsesbilleder” på skærmen.

“Brændmærker”, “efterbilleder”, og 
“spøgelsesbilleder” er et velkendt 
fænomen i LCD skærmteknologi. I de 
fleste tilfælde vil “brandmærkerne” eller 
“efterbilledet” eller “spøgelsesbilledet” 
forsvinde gradvist, efter skærmen er 
blevet slukket.

Advarsel
Alvorlig “brandmærkerne”- eller “efterbillede”- 
eller “spøgelsesbillede”-symptomer forsvinder 
ikke og kan ikke repareres. Ovennævnte skade 
er ikke dækket af garantien.

Service
Kabinettet må kun åbnes af kvalificeret 
servicepersonale.

Hvis der er behov for et dokument til 
reparation eller integration, så kontakt 
dit lokale servicecenter. (Se kapitel om 
“Kundeinformationscenter”) 

For oplysninger om transport, se 
“Tekniske specifikationer”.

Efterlad ikke din skærm i en bil/bagagerum 
under direkte sollys.

Bemærk
Kontakt en servicetekniker, hvis skærmen ikke 
fungerer korrekt, eller hvis du er usikker på, 
hvad du skal gøre, når betjeningsinstruktionerne, 
der er givet i denne manual, er fulgt.

1.2 Notationsbeskrivelser

Følgende underafsnit beskriver de 
notationsmæssige konventioner, der benyttes i 
dette dokument.

Bemærkninger, forholdssregler og advarsler 

I hele denne vejledning kan tekstafsnit være 
ledsaget af et ikon, og stå med fed eller kursiv 
skrift. Disse afsnit indeholder bemærkninger og 
punkter, hvor der skal udvises forsigtighed, eller 
advarsler. De anvendes som følger :

Bemærk
Dette ikon angiver vigtige oplysninger og 
tips, hvormed du kan gøre bedre brug af 
computersystemet.

Forsigtig
Dette ikon angiver oplysninger om, hvordan du 
undgår risiko for skader på hardwaren eller tab 
af data.

Advarsel
Dette ikon angiver risiko for personskader, og 
hvordan dette undgås.

Visse advarsler kan optræde i andre formater, 
og er eventuelt ikke ledsaget af et ikon. I 
sådanne tilfælde er den givne udformning af 
advarslen lovmæssigt obligatorisk.
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1.3 Bortskaffelse af produkt og 
emballage

Elskrot WEEE (Waste Electrical and Electronic 
Equipment)

This marking on the product or on its 
packaging illustrates that, under European 
Directive 2002/96/EC governing used electrical 
and electronic appliances, this product may 
not be disposed of with normal household 
waste. You are responsible for disposal of 
this equipment through a designated waste 
electrical and electronic equipment collection. 
To determine the locations for dropping off 
such waste electrical and electronic, contact 
your local government office, the waste disposal 
organization that serves your household or the 
store at which you purchased the product.

Your new monitor contains materials that can 
be recycled and reused. Specialized companies 
can recycle your product to increase the 
amount of reusable materials and to minimize 
the amount to be disposed of.

All redundant packing material has been 
omitted. We have done our utmost to make the 
packaging easily separable into mono materials.

Please find out about the local regulations 
on how to dispose of your old monitor and 
packing from your sales representative.

Recycling Information for Customers

Your display is manufactured with high quality 
materials and components which can be 
recycled and reused.

To learn more about our recycling program 
please visit www.philips.com/about/
sustainability/recycling.
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2. Opsætning af skærm

2.1 Installation

Emballagens indhold

VGA (optional)

DVI (optional)

Register your product and get support at

www.philips.com/welcome
190E3L

Quick

Start

VGA (valgfri)

DVI (valgfri)

Installation af stander
1. Anbring skærmen med forsiden vendt 

nedad på en blød og jævn overflade, og vær 
forsigtig med ikke at ridse eller beskadige 
skærmen.

2. Hold på foden med begge hænder, og sæt 
med en fast hånd foden ind i fodsøjlen.

(1) Fastsgør forsigtigt foden til fodsøjlen 
indtil låsen låser den på plads.

(2) Brug dine fingre til at fastspænde skruen 
under foden, og sørg for at foden er 
ordentlig fastspændt på søjlen.

1

2
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Tilslutning til PC

4

AC strømindgang
VGA-indgang
DVI-D-indgang (tilgængelig på udvalgte 
modeller)
Kensington anti-tyverisikring

Tilslutning til pc

1. Tilslut ledningen ordentligt pa bagsiden af 
skærmen.

2. Sluk for computeren og tag netledningen 
ud af stikket.

3. Slut skærmens signalkabel til videostikket 
bag på computeren.

4. Sæt computerens og skærmens 
netledninger til et stik i nærheden.

5. Tænd for computeren og skærmen. Hvis 
skærmen viser et billede, er installationen 
gennemført.

2.2 Brug af skærm

Produktbeskrivelse set forfra

190E3L:

5

6 2347

190E3L (på model 1A):

5

6 2347

Tænder og slukker for skærmen.

Sådan får du adgang til OSD-
menuen.

Gå tilbage til det forrige OSD-
niveau.

Skifter skærmformat.

Justerer lysstryken. 

Til justering i skærmmenuen. 

Skifter tilslutningskilden. 

Skifter skærmformat.

SmartImage Lite. Der kan vælges 
mellem tre funktioner: Standard, 
Internet og Game (Spil ). 
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Beskrivelse af OSD-visningen

Hvad er OSD (On-Screen Display)?

Visning på skærmen [On-Screen Display 
(OSD)] er en funktion på alle Philips LCD 
skærme. Den sætter en slutbruger i stand 
til at justere skærmindstillingerne, eller 
vælge skærmens funktioner direkte via et 
instruktionsvindue på skærmen. Et brugervenligt 
skærmvisningsinterface vises som nedenfor:

190E3L:

190E3L (på model 1A):

Grundlæggende og enkle anvisninger til 
kontrolknapperne

I skærmmenuen ovenfor, kan du bruge 
 knapperne foran på skærmen til at flytte 

markøren med, og tryk på OK knappen, til at 
bekræfte dit valg eller ændring.

OSD-menuen

Nedenstående er en generel oversigt over 
strukturen i OSD-displayet. Du kan anvende 
den som opslag, når du senere skal orientere 
dig i de forskellige justeringer.

Main menu Sub menu

VGA

DVI (available for selected model)

Picture
Wide Screen, 4:3

0~100

0~100

Picture Format

Brightness

Contrast

On, OffSmartContrast

OSD Settings
0~100

0~100

Off, 1, 2, 3, 4

5s, 10s, 20s, 30s, 60s

Horizontal

Vertical

Transparency

OSD Time Out

Setup

0~100

On, Off

Yes, No

0~100

0~100

0~100

H. Position

Auto

V. Position

Phase

Clock

Resolution Notification

Reset

Information

Language English Español, Français, Deutsch, Italiano,

Português, Русский Türkçe

Color
6500K, 9300K

Red: 0~100

Green: 0~100

Blue: 0~100

Color Temperature

sRGB

User Define

0, 1, 2, 3, 4Power LED

Input
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Meddelelse om opløsning

Denne skærm er fremstillet til optimal ydelse på 
dens native opløsning, som er 1440 x 900 @ 60 
Hz. Når skærmen bruger en anden opløsning, 
ses følgende advarsel på skærmen: Brug 1440 x 
900 @ 60 Hz for at opnå det bedste resultat.

Advarslen vedrørende den naturlige opløsning 
kan deaktiveres under Setup (Installation) i 
OSD (skærmmenuen).

Fysisk funktion

Vip

2.3 Fjern standeren og foden

Fjernelse af foden

Inden du begynder at adskille skærmens fod, 
skal du følge vejledningerne nedenfor for at 
undgå mulig beskadigelse eller personskade.

1. Anbring skærmen med forsiden vendt 
nedad på en jævn overflade, og vær 
forsigtig med ikke at ridse eller beskadige 
skærmen.

2. Fjern foden fra søjlen, ved at: 

(1) Bruge dine fingre til at løsne skruen på 
bunden af foden.

(2) Træk langsomt foden op og ned for 
at åbne låsen, der fastholder foden, og 
træk langsomt foden af søjlen.

2

1
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Fjernelse af foden
1. Du kan bruge en almindelig skruetrækker 

til at stikke ind i de to frigivelseshuller på 
hængslet, og lirk forsigtigt i hængseldækslet 
for at fjerne det.

2. Fjern de 4 skruer og fjern derefter foden 
fra skærmen.
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3. Billedoptimering

3.1 SmartImage Lite

Hvad er dette?

SmartImage Lite er forudindstillede indstillinger, 
der optimerer skærmen i henhold til indholdet, 
og som indstiller den dynamiske lysstyrke, 
kontrast, farve og skarphed i realtid. Uanset om 
du arbejder med tekstprogrammer, ser billeder 
eller ser video, så giver Philips SmartImage Lite 
den optimale skærmydelse.

Hvorfor behøver jeg det?

Du ønsker en skærm, som giver det bedste 
billede for alle typer indhold. For at øge skærm-
oplevelsen, indstiller SmartImage Lite-softwaret 
dynamisk lysstyrke, kontrast, farve og skarphed 
i realtid.

Hvordan virker det?

SmartImage Lite er en eksklusiv, førende 
Philips-teknologi, som analyserer indholdet på 
skærmen. Ud fra det valgte scenarie forbedrer 
SmartImage Lite dynamiske billeders og 
videoers kontrast, farvemæthed og skarphed for 
at forbedre det viste billede - alt i realtid og blot 
med et tryk på en knap.

Hvordan aktiveres SmartImage Lite?

1. Tryk  på for at starte SmartImage Lite 
på skærmen;

2. Tryk gentagende gange på  for at skifte 
mellem Standard, Internet og Game (Spil).

3. SmartImage Lite ses på skærmen i fem 
sekunder, men du kan også trykke på OK
for at bekræfte det.

4. Når SmartImage Lite er aktiveret, 
deaktiveres sRGB systemet automatisk. 
For at bruge sRGB skal du deaktivere 
SmartImage Lite med  foran på 
skærmen.

Udover at bruge  til at rulle ned med, kan 
du også trykke på  for at vælge og derefter 
trykke på OK for at bekræfte valget og derefter 
igen lukke Smart-billede OSD.

Der kan vælges mellem tre funktioner: Standard, 
Internet, Game (Spil).

Standard: Forbedrer teksten og dæmper 
lysstyrken for, at øge læsbarheden og 
nedsætte anstrengelsen af øjnene. 
Denne funktion øger læsbarheden og 
produktiviteten, når der arbejdes med 
regneark, PDF filer, skannede artikler og 
andre generelle kontorprogrammer.

Internet: Denne funktion kombinerer 
farvemætheden, den dynamiske kontrast 
og skarphed for at vise billeder og lignende 
klart og i levende farver - alt uden synlige 
fejl på det skannet billede og blegnede 
farver.

Game (Spil): Aktivér overdrive-kredsløbet 
for at få den bedste reaktionstid, 
reducere skæve kanter på genstande, der 
bevæger sig hurtigt på skærmen, forbedre 
kontrastforholdet mellem lyse og mørke 
områder. Denne funktion giver brugeren 
den bedste spilleoplevelse.
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Installation
Følg instruktionen og fuldfør installationen.

Du kan starte, når installationen er fuldført.

Hvis du vil begynde senere, kan du klikke 
på genvejen på skrivebordet eller på 
værktøjslinjen.

Opstartsguide
Efter installation af SmartControl Lite 
starter Wizard (guiden) automatisk, når du 
åbner programmet første gang.

Guiden leder dig trin for trin gennem 
indstillingen af skærmen.

Du kan også gå til Plug-in menuen, for at 
starte guiden på et senere tidspunkt.

I Standard-vinduet kan du indstille flere 
funktioner uden brug af guiden.

3.2 SmartContrast

Hvad er dette?

Unik teknologi, der dynamisk analyserer det 
viste indhold, og automatisk optimerer LCD 
skærmens kontrastforhold til maksimal visuel 
klarhed. Den øger baggrundsbelysningen og 
giver et klarere, friskere og lysere billede eller 
dæmper baggrundsbelysningen med henblik 
på en tydelig visning af billeder på en mørk 
baggrund.

Hvorfor behøver jeg det?

Du ønsker den allerbedste visuelle klarhed 
og visning på enhvert indhold. Smart-kontrast 
styrer den dynamiske kontrast og indstiller 
baggrundslyset, så det giver klare, friske og 
lyse spil- og videobilleder, samt viser en 
tydelig, læsbar tekst ved kontorarbejde. Ved at 
nedsætte skærmens strømforbrug, sparer du 
energiomkostninger og forlænger skærmens 
levetid.

Hvordan virker det?

Når du aktiverer SmartContrast, analyseres 
det viste indhold i realtid, og farver og 
baggrundslysets intensitet indstilles. Denne 
funktion forbedrer den dynamiske kontrast og 
giver således en bedre underholdningsoplevelse, 
når du ser videoer eller spiller spil.

3.3 Philips SmartControl Lite

Det nye SmartControl Lite-software fra Phillips 
giver dig mulighed for at kontrollere skærmen 
via et nemt, grafisk interface. Komplicerede 
justeringer hører fortiden til. Dette 
brugervenlige software guider dig gennem 
finindstilling af opløsning, kalibrering af farve, 
justering af clockning/fase, RGB-hvidpunkt osv.

Dette iøjefaldende, ikon-baseret software er 
udstyret med den seneste teknologi i algoritmer 
for hurtig behandling og reaktion, og er tilmed 
Windows 7 kompatibel, og klar til at forbedre 
din oplevelse med Philips-skærme!
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Start med Standard-vinduet:

Adjust menu (Indstillingsmenu):
Med Adjust Menu (Indstillingsmenuen) 
kan du indstille Brightness (Lysstyrken), 
Contrast (Kontrast), Focus (Fokus), Position 
(Position) og Resolution (Opløsning).

Udfør indstillingen ved at følge 
instruktionerne.

Installationen kan annulleres med Cancel 
(Annuller).
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Color menu (Farvemenu): 
Med Color Menu (Farvemenuen) kan du 
indstille RGB, Black Level (Sortniveau), 
White Point (Hvidpunkt), Color Calibration 
(farvekalibrering) og SmartImage Lite (se 
afsnittet SmartImage Lite).

Udfør indstillingen ved at følge 
instruktionerne.

Se nedenstående oversigt med 
undermenupunkter baseret på din 
indtastning.

Eksempel på Color Calibration 
(farvekalibrering):

1. “Show Me” (Vis Mig) starter vejledningen til 
farvekalibrering.

2. Start – starter en 6-trins 
farvekalibreringssekvens.

3. Quick View (Hurtigvisning) indlæser før/
efter-billederne.

4. For at vende tilbage til Color (Farve) 
vinduet, skal du klikke på Cancel (Annuller).

5. Enable color calibration (Aktiver 
farvekalibrering) - der som standard er 
aktiveret. Hvis markeringen er fjernet, kan 
du ikke udføre en farvekalibrering, ligesom 
start- og quick-visning knapperne er 
gråtonede.

6. Der skal være patentoplysninger på 
kalibreringsskærmen.

Første farvekalibreringsskærm:

Previous (Foregående) knappen er 
deaktiveret, indtil du går videre til den 
anden farveskærm.
Next (Næste) går til efterfølgende mål 
(seks mål).
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Gå til sidst til File > Presets (File > Forvalg) 
vinduet.
Cancel (Annuller) lukker UI og vender 
tilbage til plug in siden.

SmartImage Lite

Smart-Billede - tillader brugeren at ændre 
indstillingerne, for at opnå en bedre 
skærmindstilling baseret på indholdet.

Når der indstilles på Entertainment 
(Underholdning), aktiveres Smart-Kontrast og 
Smart-Svar.

Options > Preferences (Funktioner > 
Indstillinger) - er kun aktiv, når Preferences 
(Indstillinger) er valgt i Options (Funktioner)-
rullemenuen. På en ikke-understøttet skærm 
med DDC/CI er kun Help (Hjælp) og Options 
(Funktioner) til rådighed.

Viser nuværende, foretrukne indstillinger.

Funktionen aktiveres ved at afmærke feltet. 
Afmærkningsfeltet er en flip-flop.

Enable Context (Aktivér Indhold) menuen 
er som standard afmærket (Til) på 
skrivebordet. Menuen Enable Context 
(Aktivér Indhold) viser valgmulighederne i 
SmartControl Lite på Select Preset (Vælg 
Forvalg) og Tune Display (Indstil Display) 
i genvejmenuen ved at højreklikke på 
skrivebordet. Disabled (Deaktiveret) fjerner 
SmartControl Lite fra genvejsmenuen.

Enable Task Tray (Aktiver Jobbakke) 
menuen er som standard afmærket (Til) 
på skrivebordet. Menuen Enable Context 
(Aktivér Indhold) gør, at systembakkens 
ikon til SmartControl Lite vises. Et højreklik 
på jobbakke-ikonen viser menufunktionerne 
for Help (Hjælp), Technical Support 
(Teknisk Support), Check for Upgrade 
(Tjek efter opgraderinger), About (Om) og 
Exit (Afslut). Når Enable Task Tray (Aktiver 
Jobbakke) menuen er deaktiveret, viser 
jobbakke-ikonen kun EXIT (AFSLUT).

Run at Startup (Kør ved opstart) er 
som standard afmærket (Til). Når den 
er deaktiveret, starter SmartControl Lite 
ikke ved opstart og ikonet vises ikke i 
systembakken. SmartControl Lite kan 
kun startes fra genvejen på skrivebordet 
eller fra programfilen. Intet forvalg, som er 
indstillet til at køre ved opstart, indlæses 
når denne boks ikke er afmærket (er 
deaktiveret).

Enable transparency mode (Aktivér 
gennemsigtighedstilstand) (Windows 
7, Vista, XP). Standard er 0% 
uigennemsigtighed.

Options > Input (Funktioner > Indgang)
- er kun aktiv, når Input (Indgang) er valgt i 
Options (Funktioner) rullemenuen. På en ikke-
understøttet skærm med DDC/CI er kun Help 
(Hjælp) og Options (Funktioner) til rådighed. 
Alle andre faneblade i SmartControl Lite er ikke 
til rådighed.
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3. Billedoptimering

Vis Source (Kilde) instruktionsvinduet og 
nuværende indgangskildeindstillinger.

På enkeltindgangsskærme ses dette vindue 
ikke.

Options > Audio (Funktioner > Lyd) - er 
kun aktiv, når Audio (Lyd) er valgt i Options 
(Funktioner) rullemenuen.

På en ikke-understøttet skærm med DDC/CI 
er kun Help (Hjælp) og Options (Funktioner) til 
rådighed.

Help > User Manual (Hjælp > 
Brugervejledning) - er kun aktiv, når User 
Manual (Brugervejledning) er valgt i Help 
(Hjælp) rullemenuen. På en ikke-understøttet 
skærm med DDC/CI er kun Help (Hjælp) og 
Options (Funktioner) til rådighed.

Help > Version (Hjælp > Version) - er kun aktiv, 
når Version (Version) er valgt i Help (Hjælp) 
rullemenuen. På en ikke-understøttet skærm 
med DDC/CI er kun Help (Hjælp) og Options 
(Funktioner) til rådighed.

Context Sensitive (Indholdssensitiv) menu

Context Sensitive (Indholdssensitiv) menuen 
er som standard aktiveret. Hvis Enable Context 
(Aktiver Indhold) menuen er afmærket 
i Options > Preferences (Funktioner > 
Indstillinger) vinduet, ses menuen.
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3. Billedoptimering

Context menuen har fire punkter:

SmartControl Lite - når valgt, ses About 
(Om) skærmen.
Select Preset (Vælg Forvalgt) – herefter 
vises en hierakisk menu med gemte forvalg, 
der straks kan bruges. En afkrydsning viser 
det nuværende valgte forvalg. Factory 
Preset (Fabriksforvalg) kan også hentes i 
rullemenuen.
Tune Display (Indstil Skærm) - åbner 
kontrolpanelet til SmartControl Lite.
SmartImage Lite - Kontroller nuværende 
indstillinger, Standard, Internet, Game (Spil).

Task Tray (Jobbakke) menu aktiveret
Menuen i systembakken kan ses ved at 
højreklikke på SmartControl Lite-ikonet 
i systembakken. Et venstreklik starter 
programmet.

Jobbakken har fem punkter:

Help (Hjælp) - adgang til 
brugervejledningsfilen: Åbner 
Brugervejledningen med standard 
browservinduet.
Technical Support (Teknisk Support) - viser 
siden med teknisk support.
Check for Update (Tjek for opdateringer) 
- leder brugeren til PDI Landing og tjekker 
brugerens version i forhold til den nyeste 
version.

About (Om) - viser detaljerede 
referenceoplysninger : Produktversion, 
udgivelsesinformation og produktnavn.
Exit (Afslut) - Luk SmartControl Lite.

Hvis du vil køre SmartControl Lite igen, 
skal du enten vælge SmartControl Lite i 
programmenuen, dobbeltklikke på skrivebordet 
eller genstarte systemet.

Task Tray (Jobbakke) menu deaktiveret

Når Task Tray (Jobbakke) er deaktiveret i 
indstillinger-mappen, er kun EXIT (AFSLUT) 
valgmuligheden til rådighed. Hvis du helt vil 
fjerne SmartControl Lite fra systembakken, 
skal du deaktivere Run at Startup (Kør ved 
opstart) i Options > Preferences (Funktioner > 
Indstillinger).
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4. Tekniske specifikationer

Billede/Skærm
Skærmpaneltype TFT-LCD
Baggrundslys LED
Panelstørrelse 19'' W (48,26cm)
Billedforhold 16:10
Pixel pitch 0,2835 x 0,2835 mm
Lysstyrke 250 cd/m² 
Smart-kontrast 20.000.000:1
Kontrastforhold (norm.) 1000:1
Reaktionstid (norm.) 5 ms
Optimal opløsning 1440 × 900 ved 60Hz
Synsvinkel 170° (H) / 160° (V) ved C/R > 10 
Billedforbedring SmartImage Lite
Skærmfarver 16,7 M
Vertikal opdateringshastighed 56Hz - 76Hz 
Horisontal frekvens 30kHz - 83kHz
sRGB JA
Tilslutningsmuligheder
Inputsignal DVI (digital), VGA (Analog), 
Inputsignal Separat synk., synk. på grøn
Behagelighed

Brugerfunktioner
190E3L: 
190E3L(1A): 

OSD sprog
Engelsk, Fransk, Tysk, Spansk, Italiensk, Russisk, 
Simplificeret Kinesisk, Portugisisk og Tyrkisk

Andre funktioner Kensington-lås
"Plug & Play" kompatibilitet DDC/CI, sRGB, Windows 7/Vista/XP, Mac OSX, Linux 
Fod
Vip -5 / +20 

Strøm
Tændt-tilstand 17,77W (norm.), 18,98W (maks.)

Energiforbrug
(EnergyStar 5.0 testmetode) 

AC indgangsspæn-
ding ved 100VAC 
+/-5VAC, 50Hz 
+/- 3Hz

AC indgangsspæn-
ding ved 115VAC 
+/-5VAC, 60Hz 
+/- 3Hz

AC indgangsspæn-
ding ved 230VAC 
+/-5VAC, 50Hz 
+/- 3Hz

Normal funktion (norm.) 14,5W 14,4 W 14,37W
Sovetilstand 0,5W 0,5W 0,5W
Fra 0,5W 0,5W 0,5W

Varmetab*

AC indgangsspæn-
ding ved 100VAC 
+/-5VAC, 50Hz 
+/- 3Hz

AC indgangsspæn-
ding ved 115VAC 
+/-5VAC, 60Hz 
+/- 3Hz

AC indgangsspæn-
ding ved 230VAC 
+/-5VAC, 50Hz 
+/- 3Hz
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Normal drift 49,49 BTU/t 49,15 BTU/t 49,04 BTU/t
Sovetilstand 1,71 BTU/t 1,71 BTU/t 1,71 BTU/t
Fra 1,71 BTU/t 1,71 BTU/t 1,71 BTU/t
Strømdiode Til-tilstand: Hvid, standby-/sove-tilstand: Hvid (blinker)
Strømforsyning Indbygget, 100-240VAC, 50-60Hz

Mål
Produkt uden fod (B x H x D) 463,59 x 390,93 x 199,8 mm
Produkt uden fod (B x H x D) 463,59 x 320,46 x 41,1 mm
Vægt
Produkt med fod  3,19kg
Produkt uden fod 2,8kg
Produkt med emballage 4,45kg

Driftsforhold
Temperaturområde (drift) 0°C til 40°C
Temperaturområde (ikke i drift) -20°C til 60°C
Relativ fugtighed 20% til 80%

Højde
Betjening: + 3.658 m (12.000 fod)
Ikke drift: + 12.192 cm (40.000 fod)

MTBF 30.000 timer 

Miljømæssige forhold
ROHS JA
EPEAT Silver (www.epeat.net)
Emballage 100 % genbrugelig
Overholdelse og standarder

Myndighedernes godkendelser
CE Mærket, FCC Klasse B, GOST, SEMKO, TCO Godkendt, 
UL/cUL, BSMI, ISO9241-307 

Kabinet
Farve Sort (bagside), Blå (forside)
Overflade Blank

Bemærk

1. EPEAT Gold og Silver er kun gyldig hvor Philips registrer produktet. Besøg venligst www.epeat.net
for registreringsstatus i dit land.

2. Disse data kan ændres uden varsel. Gå til www.philips.com/support for at hente den seneste 
version af brochuren.
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4.1 Opløsning og forudindstillede 
funktioner

Maksimal opløsning
1440 x 900 ved 60 Hz (analogt indgang)
1440 x 900 ved 60 Hz (digital indgang)

Anbefalet opløsning

1440 x 900 ved 60 Hz (digital indgang)

Format Opløsning Type L frekv. (Hz)

480i 720 x 480 SD 60

480p 720 x 480 SD 60

576i 720 x 576 SD 50

576p 720 x 576 SD 50

720p 1280 x 720 HD 50, 60

1080i 1920 x 1080 HD 50, 60

1080p 1920 x 1080 HD 50, 60

Bemærk
Bemærk venligst at din skærm virker bedst med 
native opløsning på 1440 x 900 ved 60Hz. For 
at opnå den bedste skærmkvalitet, bedes du 
venligst bruge denne opløsning.
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5. Strømstyring

5. Strømstyring

Hvis der er installeret et skærmkort eller 
software på pc’en, der er i overensstemmelse 
med VESA DPM, kan skærmen automatisk 
nedsætte strømforbruget, når den ikke bruges. 
Når input fra tastatur, mus eller anden input-
enhed registreres, "vågner" skærmen automatisk 
igen. Nedenstående tabel viser denne 
automatiske energisparefunktions strømforbrug 
og signalering:

Energispare-definition
VESA
tilstand

Video V synk L synk Opbrugt strøm LED Farve 

Aktiv TIL Ja Ja
< 17,77 W 

(norm.)
Hvid

Sovetil-
stand

FRA Nej Nej < 0,5 W (norm.)
Hvid

(blinker) 

Kontakt Fra FRA - - < 0,5 W (norm.) FRA

Følgende opsætning bruges til at måle 
skærmens strømforbrug.

Indbygget opløsning: 1440 x 900

Kontrast: 50%

Lysstyrke: 250 nits

Farvetemperatur : 6500k med fuldt, hvidt 
mønster

Bemærk
Disse data kan ændres uden varsel.
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6. Lovmæssige oplysninger

6. Lovmæssige oplysninger

Lead-free Product

Lead free display promotes 
environmentally sound recovery 
and disposal of waste from electrical 
and electronic equipment. Toxic 

substances like Lead has been eliminated 
and compliance with European community’s 
stringent RoHs directive mandating restrictions 
on hazardous substances in electrical and 
electronic equipment have been adhered to 
in order to make Philips monitors safe to use 
throughout its life cycle.

Congratulations!

This display is designed for both you and the 
planet

The display you have just purchased 
carries the TCO Certified label. 
This ensures that your display is 

designed, manufactured and tested according to 
some of the strictest quality and environmental 
requirements in the world. This makes for a high 
performance product, designed with the user 
in focus that also minimizes the impact on the 
climate and our natural environment.

TCO Certified is a third party verified program, 
where every product model is tested by an 
accredited impartial test laboratory. TCO 
Certified represents one of the toughest 
certifications for displays worldwide.

Some of the Usability features of the TCO 
Certified for displays:

Visual ergonomics for good image quality 
is tested to ensure top performance and 
reduce sight and strain problems. Important 
parameters are luminance, contrast, 
resolution, black level, gamma curve, colour 
and luminance uniformity and colour 
rendering.

Products are tested according to rigorous 
safety standards at impartial laboratories.

Electric and magnetic fields emissions as 
low as normal household background 
levels.

Low acoustic noise emissions (when 
applicable).

Some of the Environmental features of the 
TCO Certified for displays:  

The brand owner demonstrates corporate 
social responsibility and has a certified 
environmental management system (EMAS 
or ISO 14001).

Very low energy consumption both in on- 
and standby mode minimize climate impact.

Restrictions on chlorinated and brominated 
flame retardants, plasticizers, plastics and 
heavy metals such as cadmium, mercury 
and lead (RoHS compliance).

Both product and product packaging is 
prepared for recycling.

The brand owner offers take-back options.

The requirements can be downloaded from our 
web site. The requirements included in this label 
have been developed by TCO Development in 
co-operation with scientists, experts, users as 
well as manufacturers all over the world. Since 
the end of the 1980s TCO has been involved 
in influencing the development of IT equipment 
in a more user-friendly direction. Our labeling 
system started with displays in 1992 and is now 
requested by users and IT-manufacturers all 
over the world. About 50% of all displays world-
wide are TCO certified.

For more information, please visit: 
www.tcodevelopment.com

 TCOF1058 TCO Document, Ver. 2.1

Technology for you and the planet
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6. Lovmæssige oplysninger
EPEAT

(www.epeat.net)

“The EPEAT (Electronic 
Product Environmental 
Assessment Tool) program 
evaluates computer 

desktops, laptops, and monitors based on 51 
environmental criteria developed through 
an extensive stakeholder consensus process 
supported by US EPA.

EPEAT system helps purchasers in the public 
and private sectors evaluate, compare and 
select desktop computers, notebooks and 
monitors based on their environmental 
attributes. EPEAT also provides a clear and 
consistent set of performance criteria for the 
design of products, and provides an opportunity 
for manufacturers to secure market recognition 
for efforts to reduce the environmental impact 
of its products.”

Benefits of EPEAT

Reduce use of primary materials
Reduce use of toxic materials

Avoid the disposal of hazardous waste EPEAT’S 
requirement that all registered products meet 
ENERGY STAR’s energy efficiency specifications, 
means that these products will consume less 
energy throughout their life.

CE Declaration of Conformity

This product is in conformity with the following 
standards

EN60950-1:2006 (Safety requirement of 
Information Technology Equipment).

EN55022:2006 (Radio Disturbance 
requirement of Information Technology 
Equipment).

EN55024:1998+A1:2001+A2:2003
(Immunity requirement of Information 
Technology Equipment).

EN61000-3-2:2006 (Limits for Harmonic 
Current Emission).

EN61000-3-3:1995+A1:2001+A2:2005
(Limitation of Voltage Fluctuation and 
Flicker) following provisions of directives 
applicable.

2006/95/EC (Low Voltage Directive).

2004/108/EC (EMC Directive).

2005/32/EC (EuP Directive, EC No. 
1275/2008 mplementing Directive 
for Standby and Off mode power 
consumption) and is produced by a 
manufacturing organization on ISO9000 
level.

The product also comply with the following 
standards

ISO9241-307:2008 (Ergonomic 
requirement, Analysis and compliance test 
methods for electronic visual displays).

GS EK1-2000:2009 (GS mark requirement).

prEN50279:1998 (Low Frequency Electric 
and Magnetic fields for Visual Display).

MPR-II (MPR:1990:8/1990:10 Low 
Frequency Electric and Magnetic fields).

TCO CERTIFIED (Requirement for 
Environment Labeling of Ergonomics, 
Energy, Ecology and Emission, TCO: Swedish 
Confederation of Professional Employees) 
for TCO versions.
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6. Lovmæssige oplysninger

Energy Star Declaration

(www.energystar.gov)

As an ENERGY STAR® Partner, we 
have determined that this product 
meets the ENERGY STAR®

guidelines for energy efficiency.

Note
We recommend you switch off the monitor 
when it is not in use for a long time.

Federal Communications Commission (FCC) 
Notice (U.S. Only)

This equipment has been tested and found 
to comply with the limits for a Class B digital 
device, pursuant to Part 15 of the FCC 
Rules. These limits are designed to provide 
reasonable protection against harmful 
interference in a residential installation. 
This equipment generates, uses and can 
radiate radio frequency energy and, if not 
installed and used in accordance with the 
instructions, may cause harmful interference 
to radio communications. 

However, there is no guarantee that 
interference will not occur in a particular 
installation. If this equipment does cause 
harmful interference to radio or television 
reception, which can be determined by 
turning the equipment off and on, the 
user is encouraged to try to correct 
the interference by one or more of the 
following measures: 

Reorient or relocate the receiving antenna.

Increase the separation between the 
equipment and receiver.

Connect the equipment into an outlet on 
a circuit different from that to which the 
receiver is connected.

Consult the dealer or an experienced 
radio/TV technician for help.

Changes or modifications not expressly 
approved by the party responsible for 
compliance could void the user's authority 
to operate the equipment.

Use only RF shielded cable that was supplied 
with the monitor when connecting this monitor 
to a computer device.

To prevent damage which may result in fire or 
shock hazard, do not expose this appliance to 
rain or excessive moisture.

THIS CLASS B DIGITAL APPARATUS MEETS 
ALL REQUIREMENTS OF THE CANADIAN 
INTERFERENCE-CAUSING EQUIPMENT 
REGULATIONS.

FCC Declaration of Conformity

Declaration of Conformity for Products Marked 
with FCC Logo, 

United States Only

This device complies with Part 15 of the FCC 
Rules. Operation is subject to the following two 
conditions: (1) this device may not cause harmful 
interference, and (2) this device must accept any 
interference received, including interference that 
may cause undesired operation.

Commission Federale de la Communication 
(FCC Declaration)

Cet équipement a été testé et déclaré 
conforme auxlimites des appareils 
numériques de class B,aux termes de 
l'article 15 Des règles de la FCC. Ces 
limites sont conçues de façon à fourir 
une  protection raisonnable contre les 
interférences nuisibles dans le cadre d'une 
installation résidentielle. 

CET appareil produit, utilise et peut émettre 
des hyperfréquences qui, si l'appareil n'est 
pas installé et utilisé selon les consignes 
données, peuvent causer des interférences 
nuisibles aux communications radio. 
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6. Lovmæssige oplysninger

Cependant, rien ne peut garantir l'absence 
d'interférences dans le cadre d'une 
installation particulière. Si cet appareil est 
la cause d'interférences nuisibles pour 
la réception des signaux de radio ou de 
télévision, ce qui peut être décelé en 
fermant l'équipement, puis en le remettant 
en fonction, l'utilisateur pourrait essayer de 
corriger la situation en prenant les mesures 
suivantes:

Réorienter ou déplacer l’antenne de 
réception.

Augmenter la distance entre l’équipement 
et le récepteur.

Brancher l’équipement sur un autre circuit 
que celui utilisé par le récepteur.

Demander l’aide du marchand ou d’un 
technicien chevronné en radio/télévision.

Toutes modifications n'ayant pas reçu 
l'approbation des services compétents 
en matière de conformité est susceptible 
d'interdire à l'utilisateur l'usage du présent 
équipement.

N'utiliser que des câbles RF armés pour 
les connections avec des ordinateurs ou 
périphériques.

CET APPAREIL NUMERIQUE DE LA CLASSE 
B RESPECTE TOUTES LES EXIGENCES DU 
REGLEMENT SUR LE MATERIEL BROUILLEUR 
DU CANADA.

EN 55022 Compliance (Czech Republic Only)

Polish Center for Testing and Certification 
Notice

The equipment should draw power from a 
socket with an attached protection circuit (a 
three-prong socket). All equipment that works 
together (computer, monitor, printer, and so on) 
should have the same power supply source.

The phasing conductor of the room's electrical 
installation should have a reserve short-circuit 
protection device in the form of a fuse with a 
nominal value no larger than 16 amperes (A).

To completely switch off the equipment, the 
power supply cable must be removed from the 
power supply socket, which should be located 
near the equipment and easily accessible.

A protection mark "B" confirms that the 
equipment is in compliance with the protection 
usage requirements of standards PN-93/T-42107 
and PN-89/E-06251.
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6. Lovmæssige oplysninger
North Europe (Nordic Countries) Information

Placering/Ventilation 
VARNING:
FÖRSÄKRA DIG OM ATT HUVUDBRYTARE 
OCH UTTAG ÄR LÄTÅTKOMLIGA, NÄR 
DU STÄLLER DIN UTRUSTNING PÅPLATS.

Placering/Ventilation 
ADVARSEL: 
SØRG VED PLACERINGEN FOR, AT 
NETLEDNINGENS STIK OG STIKKONTAKT 
ER NEMT TILGÆNGELIGE. 

Paikka/Ilmankierto 
VAROITUS: 
SIJOITA LAITE SITEN, ETTÄ VERKKOJOHTO 
VOIDAAN TARVITTAESSA HELPOSTI 
IRROTTAA PISTORASIASTA. 

Plassering/Ventilasjon 
ADVARSEL:
NÅR DETTE UTSTYRET PLASSERES, MÅ 
DU PASSE PÅ AT KONTAKTENE FOR 
STØMTILFØRSEL ER LETTE Å NÅ.

BSMI Notice (Taiwan Only)

Ergonomie Hinweis (nur Deutschland)

Der von uns gelieferte Farbmonitor entspricht 
den in der "Verordnung über den Schutz vor 
Schäden durch Röntgenstrahlen" festgelegten 
Vorschriften.

Auf der Rückwand des Gerätes befindet sich 
ein Aufkleber, der auf die Unbedenklichkeit der 
Inbetriebnahme hinweist, da die Vorschriften 
über die Bauart von Störstrahlern nach Anlage 

Damit Ihr Monitor immer den in der Zulassung 
geforderten Werten entspricht, ist darauf zu 
achten, daß

1. Reparaturen nur durch Fachpersonal 
durchgeführt werden.

2. nur original-Ersatzteile verwendet werden. 

3. bei Ersatz der Bildröhre nur eine 
bauartgleiche eingebaut wird.

Aus ergonomischen Gründen wird empfohlen, 
die Grundfarben Blau und Rot nicht auf 
dunklem Untergrund zu verwenden (schlechte 
Lesbarkeit und erhöhte Augenbelastung bei zu 
geringem Zeichenkontrast wären die Folge). 
Der arbeitsplatzbezogene Schalldruckpegel 
nach DIN 45 635 beträgt 70dB (A) oder 
weniger. 

ACHTUNG: BEIM AUFSTELLEN 
DIESES GERÄTES DARAUF 
ACHTEN, DAß NETZSTECKER UND 
NETZKABELANSCHLUß LEICHT 
ZUGÄNGLICH SIND. 
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6. Lovmæssige oplysninger
China RoHS 

The People's Republic of China released a 
regulation called "Management Methods for 
Controlling Pollution by Electronic Information 
Products" or commonly referred to as China 
RoHS. All products including CRT and Monitor 
which are produced and sold for China market 
have to meet China RoHS request.
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7. Kundeservice og garanti

7. Kundeservice og garanti

7.1 Philips' regler ved pixeldefekter 
på fladskærme

Philips tilstræber at levere produkter af den 
højeste kvalitet. Vi anvender nogle af branchens 
mest avancerede produktionsprocesser og 
udfører en streng kvalitetskontrol. En gang 
imellem er defekte pixler eller sub-pixler på 
TFT-skærme dog uundgåelige. Ingen producent 
kan garantere, at alle paneler vil være fri for 
pixeldefekter, men Philips garanterer, at enhver 
skærm med et uacceptabelt antal defekter 
repareres eller udskiftes under garantien. 
Dette notat forklarer de forskellige former 
for pixeldefekter og definerer de acceptable 
defektniveauer for hver type. For at være 
berettiget til reparation eller udskiftning under 
garantien skal antallet af pixeldefekter på en TFT 
-skærm overskride disse acceptable niveauer. 
For eksempel må højst 0,0004% af sub-pixlerne 
på en skærm være defekte. Desuden sætter 
Philips endnu højere kvalitetsnormer på visse 
typer eller kombinationer af pixeldefekter, der er 
mere generende end andre. Denne pixelpolitik 
gælder i hele verden.

Pixler og sub-pixler 

En pixel eller et billedelement er sammensat af 
tre sub-pixler med primærfarverne rød, grøn og 
blå. Når mange pixler sættes sammen, kan de 
danne et billede. Når alle sub-pixler i en pixel 
lyser, fremstår de farvede sub-pixler tilsammen 
som enkelt hvid pixel. Hvis de alle er mørke, 
fremstår de tre farvede sub-pixler tilsammen 
som en enkelt sort pixel. Andre kombinationer 
af oplyste og mørke sub-pixler fremstår som 
enkelte pixler i andre farver.

Forskellige typer pixeldefekter

Pixel- og sub-pixeldefekter optræder på 
skærmen på forskellige måder. Der er to 
kategorier af pixeldefekter og flere typer sub-
pixeldefekter i hver kategori.

Defekte lyse prikker

Defekte lyse prikker fremkommer som pixels 
eller underpixels, der altid lyser eller er “tændt”. 
Det vil sige, at en lys prik er en underpixel, der 
fremstår på skærmbilledet, når skærmen viser et 
mørkt mønster. Der er følgende typer defekte 
lyse prikker.

En tændt rød, grøn eller blå sub-pixel.

To sammenliggende tændte sub-pixler :
- Rød + Blå = Lilla
- Rød + Grøn = Gul
- Grøn + Blå = Cyan (Lyseblå)

Tre sammenliggende tændte pixler (en hvid 
pixel).

sub-pixler sub-pixler sub-pixler

pixler
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7. Kundeservice og garanti
Tætsiddende pixeldefekter

Da pixel- og sub-pixeldefekter af samme 
type, der ligger tæt på hinanden, kan være 
mere iøjnefaldende, specificerer Philips også 
tolerancer for tætsiddende pixeldefekter.

Pixeldefekttolerancer

For at være berettiget til reparation eller 
udskiftning på grund af pixeldefekter i 
garantiperioden skal en TFT-skærm i en Philips 
fladskærm have pixel- eller sub-pixeldefekter, 
der overskrider de tolerancer, der er gengivet i 
følgende tabeller.

Bemærk

En rød eller blå lys prik skal være mere end 50 
procent lysere end de omkringliggende prikker, 
mens en grøn lys prik er 30 procent lysere end 
de omkringliggende prikker.

Defekte mørke prikker

Defekte mørke prikker fremkommer som 
pixels eller underpixels, der altid er mørke 
eller er “slukkede”. Det vil sige, at en lys prik er 
en underpixel, der fremstår på skærmbilledet, 
når skærmen viser et mørkt mønster. Der er 
følgende typer defekte mørke prikker.

BRIGHT DOT-DEFEKTER ACCEPTABELT NIVEAU
1 tændt sub-pixel 3
2 sammenliggende tændte sub-pixler 1
3 sammenliggende tændte sub-pixler (en hvid pixel) 0
Afstand mellem to bright dot-defekter* >15mm
Samlede bright dot-defekter af alle typer 3

BLACK DOT-DEFEKTER ACCEPTABELT NIVEAU
1 mørk sub-pixel 5 eller færre
2 sammenliggende mørke sub-pixler 2 eller færre
3 sammenliggende mørke sub-pixler 0
Afstand mellem to black dot-defekter* >15mm
Samlede black dot-defekter af alle typer 5 eller færre

SAMLEDE DOT-DEFEKTER ACCEPTABELT NIVEAU
Samlede bright- eller black dot-defekter af alle typer 5 eller færre

Bemærk

1. 1 eller 2 sammenliggende sub-pixel-defekter = 1 dot-defekt

2. Denne monitor er i overensstemmelse med ISO9241-307 (ISO9241-307: Testmetoder for 
ergonimiske krav, analyse og overensstemmelse på elektroniske visuelle skærme)
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7. Kundeservice og garanti

7.2 Kundeservice og garanti

For oplysninger om garantidækning og gældende støttekrav i dit område, bedes du besøge www.
philips.com/support  website for details. Du kan også kontakte dit lokale Philips kundeservicecenter via 
nummeret nedenfor.

Kontaktoplysninger i Vesteuropa:

Land ASC Kundeservice tlf Pris

Germany Siemens I&S +49 01803 386 853 € 0,09

United Kingdom Invec Scotland +44 0207 949 0069 Local call tariff

Ireland Invec Scotland +353 01 601 1161 Local call tariff

Spain Eatsa Spain +34 902 888 785 € 0,10

Finland A-novo +358 09 2290 1908 Local call tariff

France A-novo +33 082161 1658 € 0,09

Greece Allman Hellas +30 00800 3122 1223 Free of charge

Italy A-novo +39 840 320 041 € 0,08

Netherlands E Care +31 0900 0400 063 € 0,10

Denmark A-novo +45 3525 8761 Local call tariff

Norway A-novo +47 2270 8250 Local call tariff

Sweden A-novo +46 08 632 0016 Local call tariff

Poland Zolter +48 0223491505 Local call tariff

Austria Siemens I&S +43 0810 000206 € 0,07

Belgium E Care +32 078 250851 € 0,06

Luxembourg E Care +352 26 84 30 00 Local call tariff

Portugal Eatsa Spain +351 2 1359 1440 Local call tariff

Switzerland A-novo +41 02 2310 2116 Local call tariff
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7. Kundeservice og garanti
Kontaktoplysninger til CENTRAL- OG ØSTEUROPA:

Land Callcenter ASC Kundeservice tlf

Belarus NA IBA +375 17 217 3386

Bulgaria NA LAN Service +359 2 960 2360

Croatia NA Renoprom +385 1 333 0974

Estonia NA FUJITSU +372 6519900

Latvia NA “ServiceNet LV” Ltd. +371 7460399

Lithuania NA UAB "Servicenet" +370 7400088

Romania NA Blue Ridge Intl. +40 21 2101969

Serbia & 
Montenegro

NA Kim Tec d.o.o. +381 11 20 70 684

Slovenia NA PC H.and +386 1 530 08 24

Ukraine
NA Comel +380 562320045

NA Topaz-Service Company +38 044 245 73 31

Russia
NA CPS +7 (495) 645 6746 (for repair)

NA CEEE Partners +7 (495) 645 3010 (for sales)

Slovakia NA Datalan Service +421 2 49207155

Turkey NA Techpro +90 212 444 4 832

Czech Rep. NA Asupport 800 100 697

Hungary
NA Serware +36 1 2426331

NA Profi Service +36 1 814 8080

Kontaktoplysninger til LATINAMERIKA:

Land Callcenter Kundeservice tlf

Brazil
Vermont 

0800-7254101

Argentina 0800 3330 856

Kontaktoplysninger til Kina:

Kina
Kundeservice tlf: 4008 800 008

Kontaktoplysninger til NORDAMERIKA:

Land Callcenter ASC Kundeservice tlf

U.S.A. TOS Teleplan (877) 835-1838

Canada Supercom Supercom (800) 479-6696
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7. Kundeservice og garanti
Kontaktoplysninger til APMEA:

Land Callcenter ASC Kundeservice tlf

Australia NA AGOS NETWORK PTY LTD 1300 360 386

New Zealand NA Visual Group Ltd. 0800 657447

Hong Kong / 
Macau

NA Smart Pixels Technology Ltd.
Hong Kong:Tel: +852 2619 9639
Macau:Tel: (853)-0800-987

India NA REDINGTON INDIA LTD
Tel: 1 800 425 6396
SMS: PHILIPS to 56677 

Indonesia NA PT. Gadingsari elektronika Prima
Tel: 62 21 75909053, 75909056, 
7511530

South Korea NA PCS One Korea Ltd. 080-600-6600

Malaysia NA
After Market Solutions (CE) 
Sdn Bhd

603 7953 3370

Pakistan NA Philips Consumer Service (9221) 2737411-16

Singapore NA
Philips Electronics Singapore 
Pte Ltd (Philips Consumer Care 
Center)

(65) 6882 3999

Taiwan
PCCW
Teleservices 
Taiwan 

FETEC.CO 0800-231-099

Thailand NA Axis Computer System Co., Ltd. (662) 934-5498

South Africa NA Sylvara Technologies Pty Ltd 086 0000 888 

United Arab 
Emirates

NA AL SHAHD COMPUTER L.L.C 00971 4 2276525

Israel NA Eastronics LTD 1-800-567000

Vietnam NA
FPT Service Informatic 
Company Ltd.

+84 8 38248007 Ho Chi Minh City
+84 5113.562666 Danang City
+84 5113.562666 Can tho Province

Philippines NA Glee Electronics, Inc. 
(02) 633-4533 to 34,
(02) 637-6559 to 60

Sri Lanka NA
no distributor and/or service 
provider currently

Bangladesh NA
Distributor: Computer Source 
Ltd (warranty buy-out)

880-2-9141747, 9127592
880-2-8128848 / 52

Nepal NA
Distributor: Syakar Co. Ltd 
(warranty buy-out)

977-1-4222395

Cambodia NA
Distributor: Neat Technology 
Pte Ltd (Singapore) (warranty 
buy-out)

855-023-999992
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8. Fejlfinding og FAQ

8.1 Fejlfinding

Denne side omhandler problemer, som kan 
klares af brugeren selv. Hvis problemet stadig er 
der, efter at du har prøvet disse løsninger, skal 
du kontakte Philips' kundeservice.

Almindelige problemer

Intet billede (strømdiode lyser ikke)
Kontroller, at ledningen er sat i 
stikkontakten og bag på skærmen.
Kontroller først, at strømkontakten foran 
på skærmen er i OFF (FRA), og stil den 
derefter på ON (TIL).

Intet billede (strømdiode lyser hvid)
Kontroller, at der er tændt for computeren.
Kontroller, at signalkablet er korrekt 
forbundet til computeren.
Kontroller, at der ikke er nogen bøjede 
stikben på signalkablets stik. Hvis der er det, 
skal du få kablet repareret eller udskiftet.
Energisparefunktionen kan være aktiveret

Skærm siger

Attention

Check cable connection

Kontroller, at signalkablet er korrekt 
forbundet til computeren. (Se også Quick 
Start Guiden).

Tjek, om skærmkablets stikben er bøjede.

Kontroller, at der er tændt for computeren.

AUTO (AUTOM.) knappen virker ikke
Den automatiske funktion fungerer kun i 
VGA analog-tilstand. Hvis resultatet ikke er 
tilfredsstillende, kan der foretages manuelle 
justeringer via OSD-menuen.

Bemærk
Den automatiske funktion er ikke nødvendig i 
DVI digital-tilstand.

Synlige tegn på røg eller gnister
Forsøg ikke selv at fejlfinde
Træk straks skærmens stik ud af 
stikkontakten
Kontakt straks en repræsentant fra Philips 
kundeafdeling.

Billedproblemer

Billedet er ikke centreret
Justér billedets position med funktionen 
“Auto” (Automatisk) i OSD-menuerne.
Juster billedpositionen med Phase/Clock 
(Fase/Klokke) i OSD hovedmenuen. Den 
kan kun bruges i VGA-tilstand.

Billede vibrerer på skærmen
Tjek, at signalkablet er korrekt forbundet til 
grafikkortet eller pc'en.

Lodret flimren

Justér billedet med funktionen “Auto” 
(Automatisk) i OSD-menuerne.
Eliminer de lodrette bjælker med Phase/
Clock (Fase/Klokke) i OSD hovedmenuen. 
Den kan kun bruges i VGA-tilstand.

Vandret flimren

Justér billedet med funktionen “Auto” 
(Automatisk) i OSD-menuerne.
Eliminer de lodrette bjælker med Phase/
Clock (Fase/Klokke) i OSD hovedmenuen. 
Den kan kun bruges i VGA-tilstand.
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Billedet er sløret, uklart eller for mørkt
Indstil kontrasten og lysstyrken i OSD.

Der forbliver et “efterbillede”, 
“brandmærkerne” eller “spøgelsesbillede”, 
efter at der er slukket for strømmen.

Uafbrudt visning af et stilbillede over 
længere tid, kan forårsage “brandmærker”, 
også kendt som “efterbilleder” eller 
“spøgelsesbilleder” på skærmen. 
“Brændmærker”, “efterbilleder”, og 
“spøgelsesbilleder” er et velkendt fænomen 
i LCD skærmteknologi. I de fleste tilfælde vil 
“brandmærkerne” eller “efterbilledet” eller 
“spøgelsesbilledet” forsvinde gradvist, efter 
skærmen er blevet slukket.

Sørg altid for at aktivere en pauseskærm, 
der bevæger sig, når skærmen efterlades 
uden at blive anvendt.

Du skal altid bruge en pauseskærm eller 
et andet program, der opdaterer skærmen 
regelmæssigt, hvis LCD skærmen viser 
statisk materiale i længere perioder.

Alvorlig “brandmærkerne”- eller 
“efterbillede”- eller “spøgelsesbillede”-
symptomer forsvinder ikke og kan ikke 
repareres. Ovennævnte skader er ikke 
dækket af garantien.

Billedet er forvrænget. Tekst er utydelig eller 
sløret.

Indstil pc’ens skærmopløsning som 
skærmens anbefalede, native opløsning.

Der ses røde, blå, mørke og hvide pletter på 
skærmen

De resterende prikker er normale i den 
flydende krystal-teknik, der bruges i dag. 
Se politikken om pixels for yderligere 
oplysninger.

“Tændt” lyset er for kraftigt, og det er 
forstyrrende 

Du kan justere “Tændt” lyset med 
Strømdiode i OSD-menuerne.

For yderligere hjælp, se venligst listen over 
Forbrugerinformationscentre og kontakt 
Philips's Kundeservice.

8.2 Ofte stillede spørgsmål om 
SmartControl Lite

SP1. Jeg har udskiftet skærmen på en pc 
til en anden skærm, og nu fungerer 
SmartControl Lite ikke længere. Hvad 
skal jeg gøre?

Sv.: Genstart din pc og se, om SmartControl 
Lite fungerer nu. Ellers skal du afinstallere 
og geninstallere SmartControl Lite for at 
sikre, at den korrekte driver er installeret.

SP2. SmartControl Lite fungerede fint 
tidligere, men nu virker programmet 
ikke længere. Hvad skal jeg gøre?

Sv.: Hvis nogle af de følgende handlinger har 
været udført, skal skærmdriveren måske 
geninstalleres.

Videografikadapteren er blevet udskiftet 
med en anden 

Opdater videodriver 

Aktiviteter i OS som f.eks. servicepakke 
eller programrettelse 

Opdater Windows og opdater skærm- og/
eller videodriver 

Windows blev startet med strømmen til 
skærmen slået fra eller afbrudt.

For at finde ud af dette, skal du klikke 
på My Computer (Denne Computer) 
og derefter på Properties (Egenskaber) 
-> Hardware -> Device Manager 
(Enhedshåndtering).

Hvis du ser “Plug and Play Monitor” (Plug 
& Play skærm) under Monitor (Skærm), skal 
du geninstallere. Afinstallér SmartControl 
Lite og geninstallér det.

SP3. Efter installation af SmartControl Lite 
sker der ingenting, selv om jeg klikker på 
fanen SmartControl Lite og venter, eller 
der vises en fejlmeddelelse. Hvorfor?

Sv.: Det skyldes muligvis, at din grafiske 
adapter ikke er kompatibel med 
SmartControl Lite. Hvis grafikadapteren 
er en af ovennævnte mærker, skal 
du prøve at downloade den mest 
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opdaterede grafikadapterdriver fra det 
pågældende firmas hjemmeside.
Installer driveren. Afinstallér SmartControl 
Lite og geninstallér det igen.
Hvis det stadig ikke virker, er vi bange for, 
at grafikadapteren ikke understøttes. Gå til 
Philips hjemmeside og kontrollér, om der 
findes en nyere driver til SmartControl 
Lite.

SP4. Når jeg klikker på Product Information 
(Produktinformation), ses kun nogle af 
oplysningerne. Hvad er der sket?

Sv.: Det kan være, at din 
grafikkortadapterdriver ikke er den 
mest opdaterede version, som fuldt ud 
understøtter DCC/CI grænsefladen. Prøv 
at downloade den mest opdaterede 
grafikkortadapterdriver fra det 
pågældende firmas hjemmeside. Installer 
driveren. Afinstallér SmartControl Lite og 
geninstallér det igen.

Attention

Theft mode enabled

SP5 Jeg har glemt min PIN-kode til Theft 
Deterrence (Anti-tyveri) funktionen. 
Hvad gør jeg?

Sv.: Philips servicecenter forbeholder sig 
retten til at bede om legitimation og 
godkendelse, for at kunne etablere 
skærmens ejer.
Bemærk venligst at anti-tyveri-funktionen 
leveres som gratis ekstraudstyr. Det 
eneste ansvar for den individuelle bruger 
eller organisation, er at administrere 
PIN-koden. Hvis PIN-koden glemmes, kan 
Philips kundeservicecenter nulstille koden 
for at almindeligt gebyr, når brugeren har 
bekræftet ejerskab af udstyret. Bemærk 
venligst at denne handling ikke er dækket 
af standard garantien.

8.3 Generelle FAQ

SP1: Hvad skal jeg gøre, hvis skærmen under 
installationen viser “Cannot display 
this video mode” (Kan ikke vise denne 
videotilstand)?

Sv.: Den anbefalede opløsning på denne 
skærm: 1440 x 900 på 60 Hz.

Frakobl alle kabler og forbind derefter 
pc'en til skærmen, som du brugte før.

I Windows Start Manu (Windows 
Startmenuen), vælg Settings/Control Panel 
(Indstillinger/Kontrolpanel). I Control 
Panel (Kontrolpanel)-vinduet vælg Display 
(Skærm)-ikonet. I Egenskaber for Skærm-
vinduet vælg “Settings” (Indstillinger) 
fanebladet. Under indstillinger-fanen, under 
feltet “desktop area“ (skrivebordsområde), 
skal du stille justeringsbjælken på 1440 x 
900 pixler.

Åbn “Advanced Properties” (Avanceret) og 
indstil opdateringshastigheden på 60 Hz og 
klik derefter på OK.

Genstart computeren og gentag trinene 
2 og 3 og bekræft, at pc'en er indstillet til 
1440 x 900 ved 60 Hz.

Luk for computeren, frakobl den gamle 
skærm og genforbind Philips LCD skærmen.

Tænd for skærmen og derefter for pc'en.

SP2: Hvad er den anbefalede 
opdateringshastighed på LCD skærmen?

Sv.: Den anbefalede opdateringshastighed 
på LCD skærme er 60 Hz. I tilfælde af 
forstyrrelser på skærmen skal du sætte 
den op til 75 Hz og se, om dette fjerner 
forstyrrelserne.

SP3: Hvad er .inf og .icm filerne på cd-
rom'en? Hvordan installerer jeg driverne 
(.inf og .icm)?

Sv.: Dette er skærmens driverfiler. Installer 
driverne i henhold til brugervejledningen. 
Computeren kan bede dig om 
skærmdrivere (.inf og .icm filer) eller om 
en driverdisk, når du installerer skærmen 
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første gang. Indsæt (medfølgende cd-rom) 
i pakken i henhold til vejledningerne. 
Skærmdrivere (.inf og .icm filer) installeres 
automatisk.

SP4: Hvordan justerer jeg opløsningen?
Sv.: Skærmkortet/grafikdriveren og skærmen 

bestemmer sammen opløsningerne til 
rådighed. Du kan vælge den ønskede 
opløsning under “Egenskaber for Skærm” i 
Windows® kontrolpanelet.

SP5: Hvad, hvis jeg “farer vild”, mens jeg 
justerer skærmen?

Sv.: Så skal du blot trykke på OK og derefter 
vælge “Reset” (Nulstil) for at gå tilbage til 
de oprindelige fabriksindstillinger.

SP6: Er LCD-skærmen modstandsdygtig 
overfor ridser?

Sv.: Det anbefales generelt ikke at udsætte 
skærmens overflade for kraftige stød. 
Den er beskyttet mod skarpe og stumpe 
ting. Når du håndterer skærmen, så 
pas på ikke at trykke for kraftigt på 
skærmens overflade. Det kan påvirke 
garantibetingelserne.

SP7: Hvordan rengør jeg LCD skærmens 
overflade?

Sv.: Til normal rengøring skal du blot anvende 
en ren, blød klud. Til kraftigere rengøring 
skal du bruge isopropylalkohol. Brug 
ikke andre opløsningsmidler såsom 
ethylalkohol, ethanol, acetone, hexan osv.

SP8: Kan jeg ændre skærmens farveindstilling?
Sv.: Ja, du kan ændre farveindstillingen via 

OSD på følgende måde:
Tryk på “OK” for at vise OSD (On Screen 
Display) menuen

Tryk på “Down Arrow” (Ned-pil) for 
at vælge indstillingen “Color” (Farve), 
og tryk derefter på “OK” for at angive 
farveindstillingen. Der er tre indstillinger, 
som vist nedenfor.

1. Color Temperature (Farvetemperatur) 
med to indstillinger, 6500K og 9300K. 
Med indstillinger i 6500K området 

virker skærmen varm med en rød-hvid 
farvetone, mens en 9300K temperatur 
giver en kold blå-hvid farvetone.

2. sRGB - dette er en standardindstilling, 
som sikrer korrekt udveksling af farver 
mellem forskellige enheder (f.eks. 
digitale kameraer, skærme printere, 
skannere osv). 

3. User Define (Brugerdefineret) - 
brugeren kan vælge sin foretrukne 
farveindstilling ved at indstille den røde, 
grønne og blå farve.

Bemærk
En målning af farven på lys, der udstråles fra 
et objekt, mens det opvarmes. Denne måling 
udtrykkes på en absolut skala (kelvingrader). 
Lavere kelvingrader såsom 2004K er røde, 
højere temperaturer såsom 9300K er blå. 
Neutral temperatur, 6504K, er hvid.

SP9: Kan jeg forbinde min LCD skærm til 
enhver pc, arbejdsstation eller Mac?

Sv.: Ja. Alle Philips LCD skærme er fuldt 
kompatible med standard pc'er, Mac og 
arbejdsstationer. En ledningsadapter kan 
være nødvendig for at kunne forbinde 
skærmen til dit Mac-system. Vi anbefaler, 
at du kontakter Philips salgsrepræsentant 
for yderligere oplysninger.

SP10: Er Philips LCD skærme “Plug & Play”?
Sv.: Ja, skærmene er “Plug & Play” kompatible 

med Windows 7/Vista/XP/NT, Mac OSX 
og Linux

SP11: Hvad er “billedklæbning” eller 
“billedindbrænding” eller “efterbillede” 
eller “spøgelsesbillede” på LCD skærme?

Sv.: Uafbrudt visning af et stilbillede over 
længere tid, kan forårsage “brandmærker”, 
også kendt som “efterbilleder” eller 
“spøgelsesbilleder” på skærmen. 
“Brændmærker”, “efterbilleder”, og 
“spøgelsesbilleder” er et velkendt 
fænomen i LCD skærmteknologi. I de 
fleste tilfælde vil “brandmærkerne” eller 
“efterbilledet” eller “spøgelsesbilledet” 
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forsvinde gradvist, efter skærmen er 
blevet slukket.
Sørg altid for at aktivere en pauseskærm, 
der bevæger sig, når skærmen efterlades 
uden at blive anvendt.
Du skal altid bruge en pauseskærm 
eller et andet program, der opdaterer 
skærmen regelmæssigt, hvis LCD 
skærmen viser statisk materiale i længere 
perioder.

Advarsel
Alvorlig “brandmærkerne”- eller “efterbillede”- 
eller “spøgelsesbillede”-symptomer forsvinder 
ikke og kan ikke repareres. Ovennævnte skade 
er ikke dækket af garantien.

SP12: Hvorfor viser skærmen ikke skarp tekst? 
Hvorfor viser den forrevne tegn?

Sv.: Din LCD monitor virker bedst på dens 
native opløsning på 1440 x 900 ved 
60 Hz. Brug denne opløsning for at opnå 
det bedste billede.
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